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In AutoCAD work is done using a few commands. On the bottom portion of the 

screen the command windows is displayed. Aside from selecting a command from the 

menu or toolbar, a command can also be activated by typing in the command in the 

command window. Some of the command also have shortcuts for the ease of use. 

A brief description of the commands in AutoCAD 2007 is given below:- 

Drawing Tools 

Command Name: MVSetup 

Command Shortcut: mvsetup 

Description: It is the primary set up for AutoCAD. It is performed for setting the 

units, scale factor and paper size for measurement. 

Use: 

1. Type MVSETUP, enter. 

2. Select No for enable paper size. 

3. Choose unit type. For feet, inch we have to select Architectural. 

4. Select the scale factor, enter. 

5. Type paper width, enter. 

6. Type paper height, enter. 

 

 

 

                                       Enable paper size>No 
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Choosing unit 

 

 

Fig: Scale factor, paper width and height 
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Command Name: Ortho 

Command Shortcut: F8 or ortho 

Description: It is used for drawing lines along X and Y axis. 

Use: 

1. Ortho can be off or on by clicking Ortho mode icon of status bar. 

2. Or by pressing hot key “F8”.  

Fig: Movement along X axis                                        

 

Fig: movement along Y axis 
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Command Name: Polar tracking 

Command Shortcut: polar or F10 

Description: Polar is used for regulating the movement of cursor with a particular 

angle polar tracking is used. 

Use: 

1. Clicking “Polar” button of status bar, it can be on or off. 

2. Or by pressing hot key “F10”. 

3. To fix polar snap, set increment angle on polar tracking tab of drafting setting. 

4. To get the drafting setting dialogue you have to select Tools>Drafting setting 

or press enter typing DS on command line, then the dialogue box will appear. 

Fig: Polar movement 
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Fig: Drafting setting 

 

Command Name: Object snap 

Command Shortcut: osnap 

Description: Object snap or OSNAP is used move the cursor at a particular point on 

the object. 

Use: 

1. Enter the command OSNAP in the command line. 

2. Or by clicking on “Object Snap on” box of object snap tab or by pressing F3 

key or clicking OSNAP button of status bar. 
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Fig: Drafting Settings 

 

Object snap has 13 snap modes. They are:- 

 

End point mode: Traces the end point of arc, ellipsoidal arc, line, multiline, polyline 

segment. It snaps at the corner point of any solid or 3D face i.e. limits the cursor 

movement at that point. 
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Fig: End point 

Midpoint mode: Snaps at the midpoint of arc, ellipsoidal arc, line, multiline, polyline 

segment, solid sp line or x-line. 

 

     Fig:  Midpoint 
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Center mode: Snaps at the center point of any arc, circle, ellipse or ellipsoidal arc.   

  

Fig: Center point 

Node mode: Snaps at the quadrant point of any arc, circle, ellipse or ellipsoidal arc. 

 

Fig: Quadrant point 
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Intersection mode: Snaps at the intersection point of arc, ellipsoidal arc, line, 

multiline, polyline segment, solid polyline or x-line. 

 

Fig: Intersection point 

 

Extension mode: When cursor exceeds end point of any object, there exhibits a 

temporary extended line. 

 

   Fig: Extended line 
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Tangent mode: Snaps the tangent of any arc, circle, ellipse or ellipsoidal arc. 

 

                              Fig: Tangent of a circle 

Nearest mode: Snaps at the nearest point of arc, ellipsoidal arc, line, multiline, 

polyline segment, solid polyline or x-line. 

 

Fig: Nearest of a circle 
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DRAW TOOLBAR 

Draw toolbar contains various commands which are used for drawing lines, polylines, 

circles, arcs, rectangles etc. It can be accessed by going to the Draw menu or by right 

clicking the upper right portion of AutoCAD to access ACAD from where draw 

toolbar can be enabled. . For ease of use pull the toolbar at one side of the screen to 

pin the toolbar. 

 

 

Fig: Draw menu and list of commands 
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Fig: Enabling draw toolbar 

 

Fig: Draw toolbar  
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Command Name: Line 

Command Shortcut: L 

Draw Toolbar Icon:  

Draw Menu Name: Line 

Description: As the name suggests line command is used for drawing lines. By 

activating this command once a group of connected lines can be drawn. Lines can be 

drawn with precision with the help of point coordinates, object snap, grid snap etc. 

Use:  

How to draw lines without angle: 

1. First the Line command is selected by either selecting from the toolbar or by 

entering L 

2. The first point is selected by left clicking, then the end point is selected by left 

clicking or by entering the desired length. 

 

How to draw lines with angle: 

1. First the Line command is selected by either selecting from the toolbar or by 

entering L 

2. The first point is selected by left clicking. 

3. @length<angle is typed for creating a line with length. 

 

How to draw with measurements: 

1. Enter the line command by typing L and then pressing enter. 

2. Select the first point 

3. Now type the desired length and press enter. The line will have the specified 

length. 
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Fig: Drawing Lines 
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Command Name: Xline 

Command Icon:  

Command Shortcut: XL 

Description: This command is used to draw construction lines. Construction lines are 

either straight lines that extend to infinity in both direction. Construction lines are 

temporary line work entities that can be used as references when creating and 

positioning other objects or line work. 

Use: 

To draw a construction line through a point: 

1. Enter the command xl 

2. Specify the first point 

3. Specify the second point then press enter 

 

Fig: Construction line through a point 
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For a horizontal or vertical construction line: 

1. Enter the command xl 

2. Enter H for horizontal construction line or V for vertical construction line 

3. Specify the point. 

 

Fig: Vertical and Horizontal construction line 

For a parallel construction line: 

1. Enter the command xl 

2. Type O press Enter 

3. Specify the required distance 

4. Select the line that you want to offset  

5. Specify the side on which you want  the line to be created 

Fig: Drawing parallel construction line 



17 
 

Command Name: Polygon 

Command Shortcut: pol 

Draw Toolbar Icon:  

Draw Menu Name: Polygon 

Description: Polygon is a collection of closed polylines. Polygon is used for drawing 

triangles, rectangles, pentagons, hexagons etc. This command can be used to draw a 

polygon with up to 1024 straight sides. It is most useful in mechanical drawings.  

Use: 

How to draw a polygon: 

1. Select the polygon command and enter the numbers of sides. 

2. Now select the center of the polygon 

3. Choose inscribed in circle by pressing enter or choose circumscribed about 

circle by pressing c then enter. 

4. Enter the desired radius of the circle 

 

Fig:  Polygons 
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Command Name: Rectangle 

Command Shortcut: rectang or rec 

Draw Toolbar Icon:  

Draw Menu Name: Rectangle 

Description: Rectangle command is used for creating rectangles. It is mainly used in 

geometrical, architectural and civil engineering drawings. 

Use:  

How to use the rectangle command and its various options: 

1. Select the rectangle command. 

2. Specify the first point to create a normal rectangle or press C for chamfer or 

press F for Fillet. 

3. Follow the on-screen commands and finish drawing. 

 

Fig: Different rectangles 
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Command Name: Circle. 

Command Shortcut: Circle or c⏎ 

Draw Toolbar:  

Draw Menu Name: Circle. 

Description: To create a whole circle we can use circle command in auto cad. Circle 

command is mostly use in mechanical drawing. We can create a circle by using three 

points which are not in same line. There are some other methods to create a circle. 

Use:  

Using three points to create a circle: 

1. In draw toolbar click the circle icon or enter C in the command line. 

2. Write 3P & then press Enter. 

3. Select the first point of the circle. 

4. Select the second point of the circle. 

5. Select the third point of the circle & then draw the circle. 

Using two points to create a circle: 

1. In draw toolbar click the circle icon. 

2. Write 2P & then press Enter. 

3. Select the first corner point of diameter of circle. 

4. Select second corner point of diameter of a circle. 

 

Fig: Drawing a circle passing through 3 points 
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Command Name: Arc. 

Command Shortcut: arc or a⏎ 

Draw Toolbar:  

Draw Menu Name: Arc 

Description: To create an arc in AutoCAD we can use the command arc. At first we 

can create an arc by specifying three points. We can create an arc using a start point, 

center & third point that determines the end point. Using different options, we can 

specify either the start point first or the center point first then arcs are drawn in a 

counter clockwise direction. 

Use: 

Using three points to draw an arc: 

1. In draw toolbar click the Arc icon. 

2. Select the starting point. 

3. Select the second point of the arc. 

4. Select the last point of the arc. 

Using first point, center point & last point to draw an arc: 

1. In draw toolbar click the arc icon. 

2. Now select the first point. 

3. Write C & press Enter. 

4. Select the center point. 

5. Select the last point. 

 

Fig: An arc passing through three points 
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Command Name: Multiline 

Command Shortcut: mline or ml⏎ 

Draw Menu Name: Multiline 

Description: Multiline command is used for drawing multiple parallel lines. Multiline 

style is set to Standard by default. New multiline style can be loaded from Format → 

Multiline. 

 

Use: 

1. Select multiline from the draw menu or type ML or Mline in the command 

line. 

2. Specify the start point or enter J for Justification, S for scale, ST for style. 

Justification Option: Used for controlling the double line 

Scale Option: Used for setting the distance between the two lines 

Style Option: Used for editing the style of the lines 

3. Specify the second point and other points as necessary. 

 

Fig: Multiline 
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Command Name: Point 

Command Shortcut: po ↩ 

Draw Toolbar Icon:  

Draw Menu Name: Point 

Description: This command is used to draw a point. A point has no height, breadth 

and width. It can only be selected, moved and copied. 

Use: 

Procedure for single point: 

1. Select Point → multiple point from the draw toolbar or by entering the 

command PO and press enter. 

2. Click the point where you want a single point. 

Procedure for multiple points: 

1. Selecting Point icon from draw toolbar or by Draw menu → Point → 

Multiple point 

2. To draw necessary points. 

3. Pressing Esc button the command is terminated. 

4. If the points are not visible enter the command Blipmode then click ON. The 

points will become visible and take a “+” shape. 

 

Fig: Single command and multiple command  
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Procedure for changing the point style: 

1. By default point is a dot but AutoCAD has various other types of points. 

2. Go to Format Menu→ Point Style and select the desired type and size from 

the dialog box 

3. Point size can be changed by entering command pdsize and entering the value. 

The style of the point can also be changed by entering the command pdmode 

and then entering the desire value for the style from the list given below- 

 
Fig: Values for PDMODE command 

 

 

Fig: Point Style Window 
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Command Name: Measure 

Command Shortcut: Me ↩ 

Draw Menu Name: Point → Measure 

Description: Measure (Command) Creates point objects or blocks at 

measured intervals along the length or perimeter of an object. The points or blocks 

are placed in the previous selection. You can use the Node object snap to draw an 

object by snapping to the point object. 

Use: 

1. Specify interval distance. 

2.  Type Me in command line and click enter 

3. Select Line, Arc, Circle, Polyline etc. 

Example: 

• Command Line: Me ↩ 

• Select object to measure: select the line 

• Specify length of segment: click point A 

• Specify second point: click point B 

 

Fig: Reference Drawing 

 

Fig: After using measure command 
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Command name: Block making 

Command Shortcut:  B ↩ 

Draw Toolbar Icon:   

Draw Menu Name: Block → Make 

Description: Blocks are objects that made using multiple lines. In architectural 

drawing door, window, furniture etc. are converted into blocks as they are used 

multiple times. AutoCAD has some preinstalled blocks which are described later in 

DesignCenter command. 

Use: 

1. Selecting Make block icon from draw toolbar. 

2. Writing name on ‘Block definition’ dialogue box. 

3. By clicking Select objects to select the object and right click on mouse. 

4. By cling Pick point we take the base point. 

5. And then clicking Ok. 

 

Fig: Making a block 
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Command Name: Block insert 

Command Shortcut: I↩ 

Draw Toolbar Icon:  

Draw Menu Name: Insert 

Description: This command is used for insert the created block. 

Use: 

1. We click the icon ‘Insert block’ or enter the command I. 

2. In the Name option, select the specific block or enter the name of the block. 

3. In the dialogue box there are three specific zones called Insertion point, Scale 

and rotation. We can add value and angle on these. If left checked the scale can 

later be inserted by following the on screen commands. 

4. If we want to break the object in case of inserting we will check the explode 

option. 

5. And finally we click Ok. 

 

Fig: Insert Block window 
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Name: DesignCenter 

Command Shortcut: ctrl + 2 

Toolbar Icon:  

Draw Menu Name: DesignCenter 

Description: DesignCenter is used for- 

• Browsing for drawing and symbol library 

• Updating block definitions 

• Creating shortcuts for frequently used blocks 

• Adding Furniture 

Use:  

1. Open the DesignCenter by pressing CTRL & 2 at the same time 

2. From the left of the panel the user can browse file directory 

3. To add pre-installed furniture, which came with AutoCAD 2007 go to 

Autocad2007 directory → Sample → DesignCenter. Furniture can be found 

in Home – Space Planner.dwg, House Designer.dwg, Kitechens.dwg etc. 

folder inside Blocks 

 

Fig: DesignCenter 
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Command Name: Hatch 

Command Shortcut: h⏎ 

Draw Toolbar:  

Draw Menu Name: Hatch 

Description: The process of filling a empty space in a drawing using patterns or solid 

color is known as hatching. When drawing a plan layout or an elevation of a building 

various objects such as- doors, windows, roof, stairs etc. are hatched to make the plan 

more legible.  

Use: 

1. Type h in the command line. 

2. The Hatch and Gradient window will open. Click the swatch box and select a 

pattern. 

3. Click the Pick points button and select the area that you want to hatch or click 

Add: select objects button to select individual objects. 

4. Clicking the Preview button to see the preview then adjust the angle and scale 

as necessary. Finish hatching by clicking OK. 
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Fig: Hatch and Gradient window 

Command Name: Gradient Filling 

Command Shortcut: h⏎ 

Draw Toolbar:  

Draw Menu Name: Gradient 

Description: Gradient filling or simply Gradient is a type of filling which is used for 

showing reflection of light. It is used for giving object metallic look or glassy texture 

in drawing. One or two colors are used in gradient. 

Use: 

1. Type h in the command line. 

2. The Hatch and Gradient window will open. Now click the Gradient tab on 

the upper left side of the window. 

3. Click the Pick points button and select the area that you want to hatch or click 

Add: select objects button to select individual objects. 

4. In color there is option for select one color or two color, a dropdown list for 

selecting color and a slider for adjusting the amount of tint 

5. Clicking the Preview button to see the preview then adjust the angle and 

orientation as necessary. Apply gradient by clicking OK. 

 

Fig: Gradient tab 
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MODIFY TOOLBAR 

Modify toolbar contains various commands which are used for carrying out various 

modification on drawings. Some examples are- Erase, Mirror, Array, Trim etc. 

commands. It can be accessed by going to the Modify menu or by right clicking the 

upper right portion of AutoCAD to access ACAD from where modify toolbar can be 

enabled. For ease of use pull the toolbar at one side of the screen to pin the toolbar. 

 

Fig: Modify Menu 
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Fig: Enabling the modify toolbar 

 

Fig: Modify Toolbar 
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Command Name: Erase 

Command Shortcut: E ⏎ 

Modify Toolbar Icon:  

Modify Menu Name: Erase 

Description: Erase is the command that allows to erase objects in AutoCAD. But, this 

command will erase the whole object instead of removing parts of it. This command 

removes a selected group of entities, which may be entered before or after the 

command itself is entered. 

Use:  

1. Click on the ERASE icon. 

2. Select the object to erase. 

3. Press the ENTER key. 

 

 

Fig: Erase Command Demonstration 
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Command Name: Copy 

Command Shortcut: Co ⏎ 

Modify Toolbar Icon:  

Modify Menu Name: Copy 

Description: Copy is the one of most useful command in AutoCAD. As the name 

suggest it is used making multiple copies of selected objects. 

Use: 

1. Click on the COPY icon. 

2. Select the object to copy. 

3. Select the base point. 

4. Finally select the position where you want to copy the object. Multiple 

positions can be selected to make multiple copies. 

 

 

 

Fig: Copy command 
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Command Name: Mirror 

Command Shortcut: MI ⏎ 

Modify Toolbar Icon:  

Modify Menu Name: Mirror 

Description: Mirror command is used for creating mirror objects of an object or 

drawing. It is most commonly is used in architectural, mechanical and furniture 

drawings. Door is one of the most mirrored objects in AutoCAD as some doors open 

towards the right side while others open towards the left side. 

Use: 

1. Select objects 

2. Click on the MIRROR icon 

3. Specify the first point of mirror line 

4. Specify the second point of mirror line 

5. Press Enter to keep the original drawing or Y to erase the original drawing. 

 

 

Fig: Mirror Command 
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Command Name: Offset 

Command Shortcut: O ⏎ 

Modify Toolbar Icon:  

Modify Menu Name: Offset 

Description: Offset command is used to create a line parallel to another at a certain 

distant or to create circles with variable radius while having same center point. A 10 

inch thick wall can be easily drawn using offset command. In offset command 

distance between the lines and direction are to be specified. 

 Use: 

1. From Modify toolbar click on the Offset icon.  

2.  Type offset distance and press enter key (for distance). 

3. Move the mouse (pick box) over the line and click on it. 

4. Move the mouse (cross hair) on right side of line and click. 

5. Press Enter Key to terminate the command. 

 

 

 

 

Fig: Creating a room using offset command 
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Command Name:  Array 

Command Shortcut: AR ↩ 

Modify Toolbar Icon:  

Modify Menu Name: Array 

Description: Array means arrangement. By the help of array command we can 

arrange an object in a specific arrangement and can take as many as copy we want. An 

object can be arranged in rectangular or circular form. 

Use: 

Rectangular array: 

1. Click on the Array icon in the modify toolbar or enter the command AR. 

2. In array dialogue box, click on the Rectangular array radio button. (Here it is 

elected by default) 

3. Click on Select objects button and then select the object which you want to 

array. 

4. Enter the number of rows and columns that you want in the respective boxes. 

5. In the box of Row offset and Column offset, the distance between two rows 

and two columns should be written. 

6. In the box of Angle of array, the specific angle should be written in which 

angle we want to build array the object. 

7. Click on the Preview button to see whether the array is built properly or not. If 

it is not built properly, click on the modify button and come back to Array 

dialogue and change the value. If it is built properly, click on the Accept 

button. 

 

Fig: Reference Drawing 
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Fig: Array Dialogue box 

  

Fig: Array Preview Dialogue box 

 

Fig: After Using Rectangular Array 
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Polar array: 

1. Click on the Array icon in modify toolbar. 

2. In array dialogue box, click on the Polar array radio button. 

3. Click on the select objects button and then select the object which you want to 

array. 

4. Click on the Pick center point button and select a specific point. The 

arrangement will be created around the point.  You can also uphold the value of 

X and Y. 

5. In the box of Total number of items, the number of object should be written. 

6. In the box of Angle to fill, the array size should be specified by specified angle.  

In the counter clock-wise rotation, give a negative value and in the clock-wise 

rotation it will be positive. 

 

Fig: Reference Drawing 
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Fig: Array Dialogue box 

 

Fig: After Using Polar Array 
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Command name: Move 

Command Shortcut:  M ↩ 

Modify Toolbar Icon:  

Modify Menu Name: Move 

Description: Move command is used to transfer an object one place to another. It is 

almost similar to copy command. You can click in any place to select a base point, 

then the second point is to be selected where you transfer the object. Specify the 

objects place, to move the object. 

Use: 

1. Click on the Move icon in modify toolbar or enter the command M 

2. Select the object which you want to move. 

3. Take the base point on the object or out of the object. 

4. Drag the place where you want to move the object. Then by taking the object, 

click on that dragging place. 

 

 

Fig: Move Command 
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Command Name: Rotate 

Command Shortcut: Ro ↩ 

Modify Toolbar Icon:  

Modify Menu Name: Rotate 

Description:  The Rotate command is used to rotate an object with respect to a base 

point at a specific angle. Rotate command is used in architectural drawing, mechanical 

drawing etc. 

Use: 

1. Click on the rotate icon in modify toolbar or enter ro. 

2. Select the object which you want to Rotate 

3. Select the base point. 

4. Wrote the rotation angle and press the enter button. 

 

 

 

Fig: Rotate Command 
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Command Name: Scale 

Command Shortcut: Sc ↩ 

Modify Toolbar Icon:  

Modify Menu Name: Scale 

Description: Scale command is used to make an object small or large. Scale 

command can be used in a specific ratio. For scaling, a base point should be specified 

after select an object. Then you should select the scale factor / reference length/ new 

length. 

Use: 

1. Click on the scale icon in modify toolbar. 

2. Select the object. 

3. Select the base point. 

4. Specified the scale factor or entry the reference length or new length. 

 

Fig: Scale Command 
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Command Name: Stretch 

Command Shortcut: S↩ 

Modify Toolbar Icon:  

Modify Menu Name: Stretch 

Description: The Stretch command in AutoCAD is a powerful tool. It 

can stretch or move objects, or stretch some and move others at the same time, 

depending on how someone selects them. The key to using Stretch is specifying a 

crossing selection box properly. The Stretch command starts, 

and AutoCAD prompts   to select objects. 

Use: 

1. Select STRETCH Icon 

2. Select object to stretch 

3. Specify  base point 

4. Select second point  

Example: 

Stretch the table top 1feet. 
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Fig: Reference Drawing 

 

• Command: S↩ 

• Select Objects: Select the right side of the table top (CD) by the crossing 

window 

• Select Objects: Click the right mouse button  

• Specify Base point: Click the C point 

• Specify second point: Drive the c to the right and write 12 then enter on 

ORTHO MOOD 

 

 

Fig: After using Stretch command 
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Command Name: Extend 

Command Shortcut: EX↩ 

Modify Toolbar Icon:  

Modify Menu Name: Extend 

Description: Extend command can be accessed from the toolbar or from the modify 

menu, text = Modify> Extend, or the command line prompt, type the command. 

Extend the command we can extend a line from its end (Endpoint). 

Use: 

• Select extend icon from the toolbar 

• Select Boundary edge 

• Select the object to extend 

Example: 

Connect the lines with the boundary edges. 

 

 

Fig: Reference Drawing 
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• Command: EX↩ 

• Select Object: Select the boundary edge 

• Select objects: click enter 

• Specify object to extend: Select the lines to extend 

 

 

Fig: After using Extend command 
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Command Name: Trim 

Command Shortcut: TR↩ 

Draw Toolbar Icon:  

Draw Menu Name: Trim 

Description: Trim command can be accessed from the modify toolbar toolbar or from 

the modify menu, text = Modify> Trim, or the command line prompt, type the 

command. Trim command is used for cutting off parts of the drawing. 

Use: 

• Click on the TRIM icon 

• Select objects that intersect each other and hit ENTER 

• Select the part (or parts) to be removed 

Example: 

Trim the objects of the pic. 

 

 

 

Fig: Trim command demonstration 

 

Command:  TR↩ 

Select objects: select the cutting edges  

Select object to trim: Select the lines to trim.   
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Command Name: Break 

Command Shortcut: BR ↩ 

Modify Toolbar Icon:  

Draw Menu Name: Break 

Description: The break command can create a gap between two specified points of an 

object, breaking it into two objects. If the points are off of an object, they are 

automatically projected on to the objected. Break is often used to create a space for a 

block or a text. 

Use: 

• Select break icon or type BR in command line and press enter. 

• Select the first point from where you want to create a break when prompted to 

select object. Then select the second point of the break. 

• If you have first selected the object you want to break and want to enter the 

first point then type F and enter first point of the break and continue. 

Example: 

Breaking the line from a specific point: 

 

Command: BR ↩ 

Select object: Click at A point 

Specify second break point or [first point]: Click at B point. 

There is a gap created between A and B point. 
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Command Name: Join 

Command Shortcut: J↩ 

Modify Toolbar Icon:  

Modify Menu Name: Join 

Description: As the name suggests it is used for joining lines. It is mostly used in 

architectural, mechanical and furniture drawing. This command does not work on 

blocks so they need to be exploded first before applying the join command. 

 Use: 

1.  Enter the command J or click the join icon 

2. Select the lines that you want to join then press enter the lines will be joined 

 

Fig: Join command 
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Command Name: Divide 

Command Shortcut: Divide or DIV ↩ 

Modify Toolbar Icon:  

Modify Menu: Point → Divide 

Description: Divide command is used to divide any object in definite portion. We can 

use this command for point marking and block marking on the object. By using this 

command, we can divide a linear line more than one line in same portion. In divide 

command, the marking is a reference point. 

Use: To divide an object in same portion and for point marking, we can apply the 

following steps: 

1. In command line write DIV and then press enter. 

2. Select the line, circle, ellipse, polyline, arc or spline. 

3. Write how much we want to divide object and press enter. 

4. To divide in same portion and for block marking we can apply the following 

steps: 

i. Make the block, if we want. 

ii. In command line write DIV and then press enter. 

iii. Select the line, arc, circle, ellipse, polyline or spline. 

iv. Write B and then press enter. 

v. Write the name of the definite block and then press enter. 

vi. For block alignment with divide object, write y and then press enter or 

write N and then press enter. 

vii. Write the number of divided parts we want and then enter press. 

Example: To divide the linear line in 8 portion, we can apply the following steps. 

• Command: DIV ↩ 

• Select object to divide: select the line. 

• Enter the number of segment or (Block): write 8 and then press enter. 

The definite line is divided into 8 portion. 

 

Fig: Divide Command 
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Command Name: Break 

Command shortcut: br↩ 

Modify Toolbar Icon:  

Modify Menu: Modify → Break 

Description: Break at point is used to break the selected object at a single point. 

Use:  

1. In the modify menu select the option of break at point. 

2. Command: select the single point. 

3. Command: specify first break point: select the break point of the object. Then 

see the definite portion of the object is removed. 

Example: We can use break at point command to break a line at a single point. 

• Command: Press break at point on modify tool. 

• Select object to divide: Click the line. 

• Command: specify first break point or [first point]: click at any point of the               

line. 

 

 

Fig: Break Command 
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Command name: Chamfer 

Command shortcut: CHAMFER ↩ 

Modify toolbar icon:  

Modify menu name: Chamfer 

Description: A chamfer is an angled line that meets the endpoint of two straight 2D 

objects. By using the command chamfer a bevel or chamfer can be created on an 

object. 

Use: 

1. Select the chamfer icon or type D and press enter. 

2. Specify first chamfer distance and press enter. 

3. Specify second chamfer distance and press enter. 

4. Select the first line. 

5. Select the second line. 

Example: 

Adding chamfered corner on a rectangle: 

 

 

Fig: Chamfer Command 
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• Type REC and press enter. 

• Draw a rectangular. 

• Type CHAMFER and press enter. 

• Type D and press enter. 

•  Command: Specify first chamfer distance<0.5000>: 

Type 1 and press enter. 

• Command: Specify second chamfer distance<1.000>: 

Type 1 and press enter. 

• Command: Press enter 

• Command: Select first line: Type P and enter. 

• Command: Select 2D polyline: Select the rectangular. 

 

 

 

 

 

Command name: Fillet 

Command shortcut: FILLET ↩ 

Draw toolbar icon:  

Draw menu name: Fillet 

Description: The fillet helps convert sharp edges to round edges. Even though this 

command can be bypassed using circles and trim, its use will still be appreciated 

seeing how easy getting to the result is while using it. 

Use: 

• Select the fillet command icon. 

•  Type R and press enter. 

• Specify the fillet radius and press enter. 

• Select the first line. 

• Select the second line. 
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Example: 

Fillet the corners of a square: 

 

 

 

• Type REC and press enter. 

• Command: Specify the first corner point or specify a corner point of the 

square by clicking at a place. 

• Command: Specify other corner point: Type @4, 4 and press enter. The 

square will be drawn. 

• Select fillet icon from the modify toolbar. 

• Command: Select the first object or: Type R and press enter. 

• Command: Specify fillet radius<0.5000>: Type 1 and press enter. 

• Command: Select the first object or: Type R and press enter. 

• Command: Select 2D polyline: Select the square.   
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Command name: Explode 

Command shortcut: X ↩ 

Draw toolbar icon:  

Draw menu name: Explode 

Description: The explode command breaks a compound into its component objects. 

This command explodes a compound object when you want to modify its components 

separately. This command is used on objects that can be exploded include blocks, 

polylines and regions among others. 

Use: 

1. Select explode option from the modify toolbar. 

2. Select objects that you want to explode. 

3. Press enter to end the command. 

 

 

Fig: Using Explode on polygons and rectangle 
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Command Name: Match Property 

Command Shortcut: MATCHPROP or MA or Painter ↩ 

Standard Toolbar Icon:  

Modify Menu: Match Properties 

Description: We can use properties to copy an object to other object. For example, we 

can change an object’s color, rear, line type, line, weight, light type scan, plot style,3D 

thickness etc. to other object. For matching of the properties, we can use MATCHPROP 

command. The icon is located on top portion of the screen just below the draw menu. 

Use: For copying one objects properties to other, we can apply the following steps:  

1. In command line, write MA and then press enter. 

2. Select the object which we want to copy the object’s properties. 

3. If we want to copy a particular properties, then for settings we will press S and 

then enter. 

4. Put tick mark that we don’t want to copy in the property settings dialogue box. 

5. Select the object of the object properties which we want to copy. 

Example: To copy an object properties for other object, we can apply the following 

steps: 

• Command: MA  

• Select source object: select the source object 

• Select destination object (S) (settings): select destination object 

• Select destination object (S) or (settings): select the text which is given below 

• Select destination object (s) or (settings): press enter. 

 

Fig: Match properties command 
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Command Name: Properties 

Command Line: PROPERTIES or PR or CH ↩ 

Standard Toolbar Icon:  

Modify Menu: Properties 

Short Menu: Click the right side of the mouse and click the properties 

Pointing Device: Double click on the object 

Description: Properties command is used to display the properties palette. In the 

palette, we can see the properties of any selected object. In command line, we can 

change color, layer, line type, line type scale, line weight and thickness, this 6 types of 

properties of any object. 

Use: For displaying properties palette and change the properties, we can apply the 

following steps: 

1. In command line, write PR and then press enter or click the properties icon in 

standard toolbar. 

2. Select the object which we want to change the properties 

3. Select the value we want to change and entry the new one. 

4. To remove the selection press Esc. 

Example: To find out the properties of any object we have to follow the following 

steps: 

                  Command:  PR Or click right button on the object and click on properties. 

            In this way, we can see the properties of an object and change them if we want. 
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DIMESNION TOOLBAR 

Dimension is used for showing the values of height and weight in a drawing. A 

drawing cannot be complete without specifying its dimension. Using dimension one 

can learn about the length, width & height of a room, thickness of a wall, width of the 

window and door, radius of the pipe etc. Using AutoCAD, one can easily draw 

dimensions flawlessly. 

Dimension toolbar can be accessed by going to the dimension menu or by right 

clicking the upper right portion of AutoCAD to access ACAD and then ticking 

dimension. 

  

Fig: The dimension window and list of available dimension types 
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Fig: Enabling the dimension toolbar 

 

 

 

Fig: Dimension toolbar 
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Command Name: Linear Dimension 

Command Shortcut: dli 

Dimension Toolbar Icon:  

Dimension Menu Name: Linear 

Description: Linear dimension is used for measuring the linear distance between two 

points. Linear dimension can be used to measure horizontal, vertical and rotated 

dimension. 

Use:  

1. Enter the command dli or select form the toolbar. 

2. Specify the first point, then specify the second point. Using the mouse cursor to 

move the dimension at a distance away from the drawing. If the unit does not 

match your desired unit the process is shown at the topic “Dimension Style”. 

 

Fig: Moving the dimension line 

 

Fig: Linear dimension 



61 
 

Command Name: Aligned Dimension 

Command Shortcut: dal 

Dimension Toolbar Icon:  

Dimension Menu Name: Aligned 

Description: Aligned dimension is also called true length dimension. Aligned 

dimension is parallel to the line going between two points at any angle. As a result it 

measures true length between two points at an angle.  

Use:  

1. Enter the command dal or select form the toolbar. 

2. Specify the first point, then specify the second point. Using the mouse cursor to 

move the dimension at a distance away from the drawing. If the unit does not 

match your desired unit the process is shown at the topic “Dimension Style”. 

3. (optional) At step 2, after choosing the two point type M for multi-line text, T 

for single-line text, A for text angle if you want to change these. 

 

 

Fig: Aligned Dimension 
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Command Name: Angular Dimension 

Command Shortcut: dan 

Dimension Toolbar Icon:  

Dimension Menu Name: Angular 

Description: Angular dimension is used for measuring the angle created by an arc, 

circle, lines etc.  

Use:  

1. Enter the command dan or select form the toolbar. 

2. Specify the first line or point then specify the second line. Use the mouse to get 

the angle from the direction that you want. If the unit does not match your 

desired unit the process is shown at the topic “Dimension Style”. 

3. (optional) At step 2, after choosing the two point type M for multi-line text, T 

for single-line text, A for text angle if you want to change these. 

 

 

Fig: Angular Dimension 
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Command Name: Radius Dimension 

Command Shortcut: dra 

Dimension Toolbar Icon:  

Dimension Menu Name: Radius 

Description: Radius dimension is used for showing the radius of a circle or an arc 

Use:  

1. Enter the command dra or select form the toolbar. 

2. Specify the circle or the arc of which you want to show the radius. Next the 

point where you want to show the dimension. If the unit does not match your 

desired unit the process is shown at the topic “Dimension Style”. 

3. (optional) At step 2, after choosing the two point type M for multi-line text, T 

for single-line text, A for text angle if you want to change these. 

 

Fig: Radius Dimension 
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Command Name: Diameter Dimension 

Command Shortcut: ddi 

Dimension Toolbar Icon:  

Dimension Menu Name: Diameter 

Description: Diameter dimension is used for showing the diameter of a circle or an 

arc 

Use:  

1. Enter the command ddi or select form the toolbar. 

2. Specify the circle or the arc of which you want to show the diameter. Next the 

point where you want to show the dimension. If the unit does not match your 

desired unit the process is shown at the topic “Dimension Style”. 

3. (optional) At step 2, after choosing the two point type M for multi-line text, T 

for single-line text, A for text angle if you want to change these 

 

 

Fig: Diameter Dimension 
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Command Name: Continue Dimension 

Command Shortcut: dco 

Dimension Toolbar Icon:  

Dimension Menu Name: Continue 

Description: Diameter dimension is used for showing the diameter of a circle or an 

arc 

Use:  

1. First measure the linear dimension of the first line. 

2. Next Enter the command dco or select form the toolbar. The dimension will 

continue from the last point where the linear dimension ended. 

3. Specify up to which point you want to measure the length. Continue repeating 

this 3rd step. Until the dimension is fully measured. You only need to click on 

the end points for continue dimension. Press Esc to exit. 

4. If you want to continue any previous dimension enter dco then choose the 

dimension and follow step 3 

 

Fig: Continue 
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Command Name: Dimension style 

Command Shortcut: d 

Dimension Toolbar Icon:  

Dimension Menu Name: Dimension Style… 

Description: Dimension style is used for changing various aspects of the dimension 

line an text such as Line color, line type, units, arrow size, text height, text spacing 

etc. 

Use:  

1. Enter the command d in the command bar or tap the icon. The dimension style 

manager will open. 

2. Click New to create your own dimension style or modify to make changes on 

the default dimension style. (If you are using modify skip to step 4) 

3. Clicking New will open the Create New Dimension Style window. Enter the 

name and press continue 

4. A new window will open. From here you can change different attributes of 

dimension. It has the following tabs- 

 

• Lines: From here you can change the color of the lines, line type, line 

weight, use baseline spacing for creating distance between drawing line 

and the dimension line, suppress lines etc. 

• Symbols and Arrows: From here you can make changes to the shape of 

the arrow, size of the arrow etc. 

• Text: In the text tab you can change text style, text color and text height 

to make the text more visible from a distance 

• Fit: In this tab you can assign AutoCAD to give priority to either text or 

arrow when there is a deficit in space. 

• Primary Units: It is set to decimal by default but as we use 

architectural units it is best to change it to architectural. 

• Secondary Units: It is turned off by default. Can be enable if the user 

wants to display a secondary unit inside of a third bracket 

• Tolerances: In this tab you can enable the option to add tolerances 

which makes the amount of error that is negligible in the plan visible. 

You can also change how it is to be shown here. It is turned off by 

default. 
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Fig: Dimension Style Manager 

 

Fig: Creating New Dimension Style 

 

Fig: New Dimension Style window 
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Layer Toolbar 

Layer toolbar is activated by default in AutoCAD. It is situated on top of the drawing 

window. Layering is an important tool as it can greatly reduce amount of time 

required for finishing a drawing. If for any reason layer toolbar is not activated it can 

be activated by right clicking the top right portion of the screen and selecting layer. 

 

Fig: How to show the layer toolbar 

 

 

 

Fig: Layer Toolbar 
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Command Name: Layer 

Command Shortcut: LA 

Toolbar Icon:  

Toolbar Name: Layer Properties Manager 

Description: A drawing contains many components such as wall, door, window, 

railing, texture etc. All these components have different properties. Some have 

different colors while others have different line types. As differentiating different line 

types is rather time consuming layers can be used in AutoCAD to easily create 

different types of lines. 

Use: 

How to create new layer: 

1. Go to the layer properties manager by either pressing the icon or by using the 

shortcut. 

2. Click the “New Layer” icon or press ALT+N and a new layer will be created. 

The user can activate the layer by choosing “Set Current”. Exit by pressing OK 

button. 

 

Fig: Layer Properties Manager 
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How to assign colors to a layer: 

1. Open the layer properties manager. 

2. Click on the color icon of the desired layer 

3. A dialog box called “Select Color” will be shown. Select the desired color and 

then press Ok. 

 

Fig: Assigning color to a layer 

How to turn a layer on or off: 

1. A layer can be turned on or off by clicking the bulb icon in layer properties 

manager or the icon the layer icon manager dropdown. 

 

Fig: Turning a layer on or off 
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How to freeze/unfreeze layer: 

1. Freezing a layer makes it temporarily invisible. To freeze a layer click the 

circle icon. 

 

Fig: before freezing & selecting freeze

 

Fig: After freezing 
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How to lock/unlock layer: 

1. A layer is locked when the user wants to work on one layer and keep the rest of 

the layers in a fixed position 

2. Press the Lock/Unlock icon to lock and to unlock layers 

 

Fig: Lock/Unlock icon 

 

Fig: Using cut on the plan while keeping the column layer locked 
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Assigning line types: 

1. Open Layer Properties manager & click on Line type of the layer that you want 

to change. It is set to continuous by default. 

2. Select Line type window will open which will contain the previously loaded 

line types. Select Line type window can also be opened by using the shortcut 

LT. 

3. To add more line types click load & then select the line type that you want. 

 

Fig: How to open the select linetype window 

 

Fig: The select linetype window 
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Fig: Load or Reload Linetypes window 

 

 

How to assign line weight: 

1. From the Layer Properties Manager window click on the line weight of the 

desired layer. By default it is set to 0.01 inch or 0.25 mm. 

2. Select the desired line weight from the list and click ok 

3. If the line weight is not visible in the drawing, you will have to press the LWT 

button the status bar on the bottom of the screen. 

4. If you don’t want to use the assigned line weight on a object in the same layer, 

you can go to Format → Lineweight or type LW in the command box to open 

the Lineweight settings window. 
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Fig: How to open the Lineweight window 

 

Fig: The Lineweight window 
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Fig: LWT button for making the line weights visible 

 

Fig: How to Open the Lineweight Settings window 

 

Fig: Adjust line weights for individual objects or lines here 
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How to disable plotting on a layout: 

1. With this feature the user can disable plotting for a layer. As a result that layer 

will not printed when plotting using a printer or a plotter. Go to Layer 

Properties Manager. 

2. Click on the plot icon to enable or to disable this feature. 

 

Fig: Plotting On 

 

Fig: Plotting Off 
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Plotting/Printing 

Command Name: Plot 

Command Shortcut: CTRL + P 

Standard Toolbar Icon:  

File Menu Name: Plot… 

Description: Plot is used for printing the Drawing. With this command you can print 

in monochrome or in grayscale, create pdf or an image format etc. 

Use:  

1. Press CTRL + P or go to File → Plot. This will open the Plot window. 

2. From here- 

• Name: Give the print setup a name, load previous print setup etc. 

• Printer/plotter:  

i. Name: Select the printer for printing with the printer or select 

DWG to PDF.pc3 to print to PDF, Publish toWeb JPG.pc3 for 

JPG file, Publish toWeb PNG.pc3 for PNG file. 

ii. Plot to File: As the name suggests ticking this option creates a 

file. 

• Paper Size: From the dropdown list select the paper that you are using. 

Most common paper size is A4 210 mm x 297 mm. 

• Plot Area: From the dropdown list select window then specify the area 

that you want to plot using the mouse 

• Plot Offset: Tick center the plot. 

• Plot Scale: Tick Fit to Paper. 

• Clicking the Arrow button near the Help button will extend the window. 

• Plot Style Table: From the dropdown list you can select monochrome 

or grayscale mode, 100% or 200% screening etc. 

• Shaded Viewport Options: Here you can change the Shading of the 

plot, change the shade quality etc. 

• Plot Options: Here you can add Plot stamps, enable background 

plotting etc. 

• Drawing Orientation: Here you can select either Portrait or Landscape 

printing and tick the option for upside-down plotting. 
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Fig: Plot window & recommended settings 

 

Fig: Selecting the window to be plotted 
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